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How to Create an Accessible Document 

Introduction  

Accessibility means that something can be accessed by anyone regardless of disability. Accessible documents and the 

information therein can be accessed by anyone regardless of how they read.  

People with print disabilities read in many different, non-traditional ways. For example, a person may use a screen reader to 

read aloud the information in a document or a refreshable braille display that displays the text using moveable pins that form 

the shapes of braille characters. People with low vision or cognitive disabilities may want to enlarge text with screen 

magnification and/or use text-to-speech software.  

As content creators, we have the opportunity to create documents that can be accessible to those who read differently. The 

main changes that we can make involve formatting our documents so that they do not rely solely on visual cues. We can 

ensure that our content is as readable as possible, considering things like colour contrast, font size, and clarity of text. 

Incorporating features that support accessibility is easy and it will make a significant impact for people who access that 

information differently. For some, it will mean the difference between access to information and information that is unreadable. 

The following document outlines the main features in Microsoft Word that will make a document more accessible to people 

who use assistive technology or who have different reading needs.  Incorporating these simple changes will make your 

documents inclusive and accessible. Navigating Your Document 

To begin, open the Navigation pane. The Navigation pane lets you quickly search or navigate through your document. This 

handy pane will display your heading order and let you navigate by clicking on a heading in the outline to move directly to that 

heading or by clicking on a page thumbnail to move to that page. There are several ways this pane can be accessed:  

How to Access the Navigation Pane: 

1. Go to the “Review” tab on the ribbon bar and select “Check Accessibility” under the Accessibility area of the ribbon 

2. Choose “Check Accessibility” 

3. When the drop-down menu appears, click on the 3rd option, “Navigation Pane”  

Option 2  

1. Select the “View” tab in the top ribbon 

2.  Check the “Navigation Pane” checkbox in the “Show” area  

3. The Navigation Pane will display the structure of your document in a list on the left-hand side of the screen  

Tip: You can also access the pane by pressing the Control+F keys on the keyboard. 

Heading Styles 

Using proper heading styles in your document is one of the most important things you can do to create a navigable (and 

accessible) document. Headings create structure beyond visual cues and are readable by screen readers and other assistive 

technologies. Screen reader users can use shortcut keys to jump quickly between headings in a document to locate the 

information they need. You can create headings by applying Word’s built-in heading styles.  

Headings will appear in the Navigation pane, similar to a table of contents. Using headings can save time when formatting 

documents and will create a structure that converts to PDF and other formats. 
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Always use heading levels in cascading order (heading 1, then 2, then 3, and so on as your document’s structure requires). 

Make sure not to jump heading levels (for example going from heading 1 to heading 3 with no heading 2 in between).  

Heading styles can be customized as desired.  

How to apply heading styles: 

1. Select the “Home” tab in the ribbon at the top of the page and look for the Styles pane. To expand the Styles pane, click 

the small square in the bottom right-hand corner of the pane or use the keys Alt+Ctrl+Shift+S. The pane will appear along 

the right-hand side of the document.  

2. If the desired styles (i.e. headings) are not appearing, select “Options” at the bottom of the Styles window and use the 

drop-down menu to find the styles you want to display.  

3. Highlight the text to which you would like to apply the heading.  

4. Select the appropriate heading level in the Styles Pane (starting with Heading 1). 

5. The text should update and become a heading. That heading should now be visible in the Navigation pane. 

How to modify a heading style:  

1. In the Styles pane, open the drop-down menu for the heading that you want to modify 

2. Select “Modify…” 

3. Modify the style to your heart’s content. You can change the font, size, colour, spacing, etc. 

4. Once you change the style, all the other text with that assigned style will automatically update to match.  

How to match a heading to an existing style: 

1. highlight the block of text,  

2. right click the heading in the Styles pane, and  

3. select “update to match heading selection”. If other headings are being used, this will update them all. It is an easy way to 

customize the headings in an existing document. 

Images 

Images such as pictures, screenshots, icons, charts, tables, and infographics convey important information. It is important that 

all images in a document include alternative text (also known as alt text), which is a written description of the image. If a reader 

is unable to see the image, all the information relayed in that image is unavailable unless there is adequate alt text. The alt text 

should be concise but include enough information to relay the main features of the image.  

Images that convey a lot of information, such as infographics or charts, will need a “long description” or a caption as well as alt 

text. A long description (anything more then 6 sentences) can appear wherever makes sense in the document, such as below 

the image, in a footnote, or in an appendix. Ensure that you include a brief alt text description for the image itself and indicate 

in that alt text where the long description can be found. 

Strictly decorative images should be labeled “decorative,” but this only applies if the image does not convey any information. 

An artistic dividing line or symbol at the end of a paragraph or page is an example of a decorative image. 

Note: Do not use the “mark as decorative” checkbox because this can cause accessibility concerns for screen reader users 

who are running older versions of Microsoft Word. 

Logos can be described as “logo of…” and the description can include a very brief description of the logo itself. 

Finally, images need to be placed in line with text to be readable by screen readers. Do not wrap text around an image or 

place the image behind or in front of text. Screen readers will not be able to access those images.  
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How to apply alternative text: 

1. Select the image 

2. Right click or open the context menu with the applications key or shift+F10 

3. Choose “Edit Alt Text” 

4. Add a concise description conveying the purpose of the image/object in the context of the document. 

5. If an image is purely decorative, type “decorative” in the alt text box (do not check the “mark as decorative” box). 

6. Close the dialog box (there is no “ok” or “save” button). 

Note: The “Generate a description for me” button relies on artificial intelligence to generate a description of an image. It is not 

effective in creating an alt text description conveying the relevance of the image to your document. It is recommended you do 

not use this feature. 

How to place an image in-line with text: 

1. Select and right click the image.  

2. Open the “Layout Options” icon  

3. Select “In Line with Text” 

Or 
1. Select the image  

2. A “Picture Format” tab will appear along the top menu. Open it.  

3. Under the “Wrap Text” drop-down menu, select “In-line with Text”. 

Tables 

Tables should only be used when presenting tabular data, and should never be used to format a document. All the related 

data in a table should correlate appropriately and logically (for example, columns should be labelled and each item in the table 

should have its own cell). Avoid using split or merged cells in a table. This can confuse the reading order and usually only 

makes sense visually.  

Table header rows need to be marked as header rows for assistive technology to recognize them. If marked properly, a screen 

reader will read the header row before reading the corresponding cell. This makes it easier to navigate through a table without 

getting lost.    

Tables also require alt text. Alt text for a table should include a very brief description of the table.  

An image of a table should never be used instead of a table. Use the built-in Microsoft table feature to create a table.  

How to repeat the header row:  

1. Highlight the content in the top row of the table (the header row) and right click. 

2. Select “Table Properties" from the drop down menu.  

3. Select the “Row” tab and check “Repeat as header row at the top of each page”. 

How to apply alternative text to a table:  

1. Select and right-click the table 

2. Select “Table Properties”  

3. Select the “Alt Text” tab  

4. Add a title and the alt text description to the appropriate boxes. The alt text will be automatically saved.  

Tip: To check the reading order of a table, tab through the table to make sure that data is in the proper order. This will be the 

same order that a screen reader will read the table.  

Hyperlinks (websites) 
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Did you know that screen reader users can extract hyperlinks from a document and view/browse them as a list? Have you 

ever thought about what it sounds like when a screen reader reads aloud a very long website URL? 

A hyperlink should be embedded in descriptive text that will make sense out of context. If a hyperlink is embedded in non-

descriptive text, such as “click here,” it will not make sense when extracted and presented for browsing by a screen reader. 

Too much information, such as a URL containing a mixture of numbers, letters and symbols, can be confusing and tiring for 

the reader. 

For example, if you are including a link to a step-by-step “how to create accessible hyperlinks” YouTube video, instead of 

using the hyperlink https://www.youtube.com/watch?v=rRec4qjsrSs use descriptive text to indicate the destination of the link: 

how to create accessible hyperlinks. Both hyperlinks will take the reader to the same web page, but the more descriptive link 

provides clarity for the screen reader user.  

How to create a hyperlink from plain text: 

1. Highlight the descriptive text that will become your hyperlink. 

2. Right click and select “Hyperlink” or use the shortcut Control+K. 

3. Add the website/address to the “Address” bar. 

4. The descriptive text should now appear as a hyperlink. 

How to change the name of a hyperlink/URL: 

1. Right click on the hyperlink (or hyperlinked URL).  

2. Choose “Edit Hyperlink” from the dropdown menu. 

3. In the “Text to display” box, enter the label/descriptor of the hyperlink.   

4. The hyperlink should now display the updated descriptive version of your URL. 

Language 

Did you know that screen readers read text in different languages?  Did you know that when you are creating a document, 

there is a language assigned to every word in that document? Whenever there is text in another language, you should identify 

the language of the text appropriately. This ensures that assistive technologies can render the content accurately and read the 

content according to the pronunciation rules for that language. It can be very distracting and confusing to have a screen reader 

read aloud information in English that is meant to be in a language that is not English.  

Note: you do not need to change the language for words that are incorporated into English (for example, rendezvous). 

How to change the language in Word: 

1. Highlight the text or section that is in a language other than English. 

2. At the bottom left of the Word window, click on the language (beside the page and word count). Alternatively, select the 

“Review tab”, “Language”, and “Set Proofing Language.” 

3. Select the appropriate language.  

Spacing and Paragraph Formatting 

Spacing means the space around text (margins, line spacing, word spacing, text alignment, indents, etc.). Sometimes 

document creators use “carriage returns” (i.e. pressing Enter) or the space bar to obtain a specific visual effect in a document, 

like getting a paragraph on a new page, adding white space between elements in a document, or indenting a paragraph. 

However, if you press the Enter key two or more times, a screen reader may interpret the “Enter” as a new paragraph with no 

text. The screen reader may also communicate the word “blank” for every empty line. 

To be formatted accessibly, use the paragraph feature in Word to add space between lines or paragraphs. You can also use 

the paragraph feature to add page breaks. The spacing may be standard throughout the document, or you can create specific 

spacing for certain sections.  

https://www.youtube.com/watch?v=rRec4qjsrSs
https://www.youtube.com/watch?v=rRec4qjsrSs
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If possible, left-align body text and do not justify paragraphs. Justifying paragraphs adds additional spaces between letters and 

can be more difficult to read for some people. 

If the document is written in columns, use Word’s column feature. Do not try to create your own columns by using extra spaces 

or tabs.  

How to format spacing and paragraphs: 

1. Highlight the text or paragraph to be formatted. 

2. Right click and select “Paragraph” or navigate to the “Home” tab on the menu bar and choose “Line and Paragraph 

Spacing” in the Paragraph area of the ribbon. 

3. Format the paragraph or text as desired. There are many options for formatting. You can add spacing above or below the 

paragraph(s), indent lines or paragraphs, set your line spacing to double or single lines, create page breaks, etc.  

4. Look at the “Preview” box to verify the formatting is correct. 

Tip: You can format the spacing in your “Headings” or in the “Normal” text in the Styles pane if you want to create a standard 

spacing for your document. For example, the Heading 1 in this document is set to have an 18-point space before and a 0-point 

space after (with an assigned 20-point font). This ensures that the headings always have a break from the sections before and 

are connected to the text below (because that is how I like it to look).   

Colour Contrast 

Colour can highlight important information and serve as a visual indicator. However, for those who have low vision, 

colorblindness or a cognitive disability, the use of color can hinder how well they can see or interpret material. Colour should 

also never be solely used to relay important information. It can be used, but you should consider using other indicators 

alongside the colour. 

Colour contrast is the difference between the value of the foreground colour (usually the font colour) and the background 

colour. If there is not sufficient colour contrast between the foreground and background, some people may not be able to 

differentiate the text from the background, or it may make deciphering the text more difficult than it needs to be. There should 

be sufficient colour contrast to make the text accessible to everyone.  

WCAG (W3C Web Content Accessibility Guidelines) 2.0 level AA requires a contrast ratio of at least 4.5:1 for normal text and 

3:1 for large text. Level AA is a good level to aim for.  

There are many resources that check for sufficient colour contrast. We recommend using WebAIM’s Colour Contrast Checker. 

This tool will tell you if the contrast is sufficient for both normal text and large text. When you enter the known colour values 

into WebAIM’s form, it will tell you if it passes or fails WCAG Level AA or AAA standards. You may also use the slider in the 

tool to find new colour codes that meet the accessibility standards (if yours do not meet them).  

How to find colour values for Font: 

1. Highlight the text. 

2. Go to the Home tab on the ribbon bar and select “Font Colour” found in the Font area of the home ribbon 

3. Select “More Colours” 

4. Go to the Custom tab. 

5. Under the “Color model” drop-down field, there are three fields (Red, Green, Blue) populated with numbers that make up 

the RGB formula for the colour of the text. 

6. Input these numbers into WebAIM’s contrast checker. Make sure to include the background colour if it is something other 

than white.   

7. The contrast checker will identify which colours “pass” or “fail” the visual test. 

How to find colour values for background colours: 

1. Select the page/area for which you want the background RGB code. 

2. Navigate to the Design tab on the menu bar and select Page Color in the Page Background area of the ribbon. 

https://webaim.org/resources/contrastchecker/
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3. Select More Colours. 

4. Go to the Custom tab. 

5. Under the “Color model” drop-down field, there are three fields (Red, Green, Blue) populated with numbers that make up 

the RGB formula for the colour of the background. 

6. Input these numbers into WebAIM’s contrast checker.  

7. The contrast checker will identify which colours “pass” or “fail” the visual test. 

Textboxes  

Text boxes are sometimes used for formatting or to draw attention to a particular part of the document. However, currently text 

boxes are not an accessible feature in Word. Screen readers will often miss the text box entirely, so even adding alt text is not 

helpful. Therefore, if possible, avoid the use of text boxes in documents all together. If text boxes are being used to highlight 

text or for aesthetic reasons, consider using borders and shading around the text instead (just make sure there is sufficient 

colour contrast if using shading).  

Footers and Headers 

Headers and footers hold document information but should never be the only place where important information is provided. 

Screen readers do not automatically identify information in the header/footer and will not read that information unless the 

screen reader user knows to direct the screen reader to do so. Make sure if you add important content to the header/footer, 

you also repeat it in the document. For example, if an AR number is only found in the header or footer of a document, 

someone using a screen reader will not be able to identify the AR number.  

Tip: Do not manually type page numbers into the headers and footers. Use the Insert tab then “Page Number”. The page 

numbers may be formatted from there.  

Fonts 

Both font style and font size are important to consider when creating a document. At least 11-point font size should be used 

within the main body of text (12-14 point is even better, especially for printed documents) and a minimum 9-point size in 

headers and footers. The font sizes should allow for zoom or magnification without being distorted.  

Some fonts are easier to read than others. It is best practice to use clear and easy to read fonts (often recommended are 

sans-serif fonts), such as Arial, Calibri, and Verdana.  

Accessibility Checker 

Microsoft Office has a built-in Accessibility Checker, which finds accessibility issues and warnings, explains the reasons for 

them, and offers solutions.  

Please note that the Accessibility Checker is an automated tool and will not catch every accessibility issue that may exist in 

your document. It is best used in conjunction with awareness about accessibility features as well as a manual check.  

Issues that should be manually inspected include:  

• Alternative text quality   

• Complex image descriptions 

• Captions 

• Use of headings 

• Formatted lists 

• Descriptive links 

How to Access the Accessibility Checker: 

1. Go to the “Review” tab on the ribbon bar and select “Check Accessibility” under the Accessibility area of the ribbon. 

2. Choose “Check Accessibility”. 
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3. The Accessibility panel will open on the right-hand side of the window and will display any accessibility errors it has 

detected along with explanations and ways to fix them. 

Tip: Check the Keep accessibility checker running while I work checkbox to be notified of accessibility errors while you work. 

PDF Documents 

If you are making your Word document accessible, you will want to make sure that all that work is maintained if you are 

converting your document to a PDF. If you save it correctly, the accessibility information will be kept intact when converted to 

PDF. 

Sometimes PDFs are strictly images and screen readers cannot access the content at all. For example, when a document is 

physically scanned on a photocopier scanner and sent to an email, that content is one big image, even if it looks like text. And 

that image is inaccessible to screen readers.  

If a document requires a physical signature and is therefore scanned, include a copy of the original PDF or Word document, as 

the scanned copy will not be accessible. It is best practice to use digital signatures whenever possible.  

Avoid the “print to PDF” function when you are saving a document that is going to be shared. Always save PDFs as per the 

instructions below so that they can be accessed by all readers. 

People who have dyslexia or other cognitive differences may access content by modifying the document in ways that suit their 

own reading requirements, such as changing the font or spacing. Because PDFs do not allow for adjustment, they are not 

considered a very accessible format and can pose challenges for some readers. If you are required to use PDFs, please make 

other formats available or, at a minimum, indicate that other formats are available upon request.  

How to save as PDF: 

There are two methods available to save your Word file as an accessible PDF file depending on whether you have an Adobe 

add-in installed on your computer for Word. 

Saving a Document as PDF if you have the Adobe Add-In: 

1. Either navigate to the File tab on the ribbon bar and choose Save as Adobe PDF or go to the Acrobat tab on the ribbon 

bar and choose Create PDF. 

2. select Options and ensure “Enable Accessibility and Reflow with Tagged Adobe PDF” and “Create Bookmarks” are both 

checked. 

Saving a Document as PDF without an Adobe Add-In: 

1. Navigate to the File tab on the ribbon bar and select Save As. 

2. Select PDF as the “Save as type” 

3. Select Options. 

4. Check the “Create bookmarks using headings” and “Document structure tags for accessibility” checkboxes. 

Tip: Adobe also has a built-in accessibility checker that can be used to identify accessibility issues in a PDF document. 

Final Thoughts 

An accessible document is actually a well-structured document and will benefit everyone. 

We all have the power to make the world a bit more accessible. Let’s use that power and build more accessible resources for 

Albertans and other GoA employees.  

 Please share information and resources with colleagues, even those you think are the “experts.” We are all learning together 

and there is so much we can learn from one another. 
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Accessible Document Checklist 

If it is helpful, please use the following checklist to review your documents for accessibility. 

Accessible Document Features Y/N 

Headings: Headings are used in cascading order and they appear in the Navigation Pane. 
 

Headers and Footers: Important information (title, AR number, etc.) is stated somewhere 

other than in the header and/or footer. 

 

Font: Font is Sans Serif and is at least 11 point in body text and at least 9 point in headers 

and footers. 

 

Tables: Cells in tables are not merged or split.  
 

Tables: The Header Row is repeated at the top of the table (header row checkbox is ticked). 
 

Tables: Tables are not being used for formatting purposes. 
 

Images: Images are in line with text. 
 

Images: Alternative text has been added to all images and graphics. 
 

Complex Images: Long descriptions have been added to complex images. 
 

Formatting: Body text is not justified and is aligned left. 
 

Spacing: There is sufficient space between lines. The words in the document do not look 

crowded.  

 

Spacing: Paragraph spacing is formatted using Word features (Paragraph feature) and not 

blank spaces. 

 

Hyperlinks: Hyperlinks are embedded in descriptive/meaningful text. 
 

Text Boxes: Text boxes have been avoided. If needed for formatting or aesthetic reasons, 

borders and shading are used instead.  

 

Colour Contrast: Any colour (other than any black and white combination) has been checked 

for sufficient colour contrast.  

 

Accessibility Checker: The document has been checked by the Word Accessibility Checker 

and issues have been addressed.  
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Accessible Document Features Y/N 

Saving as PDF: If saving document as a PDF without the Adobe add-in, “Create bookmarks 

using headings” and “Document structure tags for accessibility” have been selected. 

 

Saving as PDF: If saving document as PDF with the Adobe add-in, “Enable Accessibility and 

Reflow with Tagged Adobe PDF” and “Create Bookmarks” are both checked. 

 

Resources 

Here are some great additional resources for creating accessible documents. This list has been compiled by the wonderful 

people at the National Network for Equitable Library Service (NNELS). 

Accessibility for Word 

• Office Accessibility Center - Resources for people with disabilities 

• Microsoft Support: Accessibility Checker 

• Microsoft Support: Rules for the Accessibility Checker 

• Microsoft Support: Accessible Hyperlinks 

• Microsoft Support: Creating Accessible Tables  

• Microsoft Support: Templates: Get templates designed for accessibility 

• Microsoft Support: Create a template 

• Microsoft Support: Use color and contrast for accessibility 

Accessibility for PDF 

• Create and verify PDF accessibility (Acrobat Pro): Walks through the built-in checker 

• Creating accessible PDFs: Explains how to create an accessible PDF and has a lot of useful information on Accessibility for 

PDFs 

• PDA/UA foundation: is one of the organizations that creates standards for accessibility in PDFs 

• PDA/UA has a free checker App: though we recommend using Adobe Acrobat Pro’s built-in checker. 

• PDF Techniques for WCAG 2.0: this document breaks down all the applications you can use for creating an accessible 

document. Word and Adobe are the most accessible. 

• TPGI YouTube Video on Intro to Accessible PDFs: free online tutorial for checking and fixing a PDF 

• TGIF article on PDF accessibility 

Creating Image Descriptions for Alt-text 

• Describing Images in Publications is a DAISY webinar that introduces Image Descriptions 

• The Art and Science of Describing Images Part Two is a DAISY webinar that goes into describing Maps, Graphs, and 

Charts 

• W3C's Tutorial on Images focuses more on websites, but has useful tips for describing symbols and images in sequence. 

• AccessiblePublishing.ca Guide to Image Description provides general guidelines for publishers. This page was created by 

our accessibility testing team. 

• Poet Training Tool provides an interactive tutorial on how to describe all types of images, and is great to practice your 

writing skills! 

• Long description techniques: DAISY Knowledge Base 

• WCAG Techniques for Long description: G73 – G74 – G92 

• The Art and Science of Describing Images Part Two: DAISY webinar that goes into describing Maps, Graphs, and Charts 

Other Useful Links 

• WCAG Language Guidelines: Accessibility guidelines for when to apply Languages 

https://nnels.ca/
https://support.microsoft.com/en-us/office/office-accessibility-center-resources-for-people-with-disabilities-ecab0fcf-d143-4fe8-a2ff-6cd596bddc6d?redirectsourcepath=%252fen-us%252farticle%252faccessibility-in-office-365-aca7accf-58a0-4467-be5c-24a7e7933a9d
https://support.microsoft.com/en-us/office/make-your-content-accessible-to-everyone-with-the-accessibility-checker-38059c2d-45ef-4830-9797-618f0e96f3ab
https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/office/video-create-accessible-links-in-word-28305cc8-3be2-417c-a313-dc22082d1ee0?ui=en-us&rs=en-us&ad=us
https://support.microsoft.com/en-us/office/video-create-accessible-tables-in-word-cb464015-59dc-46a0-ac01-6217c62210e5
https://support.microsoft.com/en-us/office/get-accessible-templates-for-office-ca086caa-2bd2-4ac8-8c12-4cd495bd4d76
https://support.microsoft.com/en-us/office/create-a-template-86a1d089-5ae2-4d53-9042-1191bce57deb
https://support.microsoft.com/en-us/office/use-color-and-contrast-for-accessibility-in-microsoft-365-bb11486d-fc7d-4cd9-b344-16e2bc2a2387
https://helpx.adobe.com/ca/acrobat/using/create-verify-pdf-accessibility.html
https://helpx.adobe.com/ca/acrobat/using/creating-accessible-pdfs.html
https://pdfua.foundation/en
https://pdfua.foundation/en/pdf-accessibility-checker-pac
https://www.w3.org/TR/WCAG20-TECHS/pdf
https://www.youtube.com/watch?v=5Vb0fJ5p7Mo
https://www.tpgi.com/pdf-accessibility/
https://daisy.org/news-events/articles/describing-images-in-publications-w/
https://daisy.org/news-events/articles/art-science-describing-images-part-2-w/
https://www.w3.org/WAI/tutorials/images/
https://www.accessiblepublishing.ca/a-guide-to-image-description/
http://diagramcenter.org/making-images-accessible.html
http://kb.daisy.org/publishing/docs/html/images.html
https://www.w3.org/WAI/WCAG21/Techniques/general/G73
https://www.w3.org/WAI/WCAG21/Techniques/general/G74
https://www.w3.org/WAI/WCAG21/Techniques/general/G92
https://daisy.org/news-events/articles/art-science-describing-images-part-2-w/
https://www.w3.org/WAI/WCAG21/Understanding/language-of-parts.html
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• NNELS Services: Includes information on paid workshops on Alt-text and more! 

• WebAIM: Colour contrast checker that checks for sufficient contrast between the text and the background. Tip: If your 

contrast fails, use the slider bar to find a colour that is close to the original that you can use.  

• WCAG Contrast Checker: Colour contrast checker. You can import pictures to check for compliance. The checker also has 

a colour blindness simulator.  

https://nnels.ca/services-publishers
https://webaim.org/resources/contrastchecker/
https://contrastchecker.com/

